[image: image1.png]Question 1/14
Which of the following options is required in the fich client logon

window?
secctone
O userd
© Group
O Role.
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How are Teamcenter views displayed?
secctone
O Automaticaly, when you select an appiicaton.
O Manualy, when you select a Teamcenter object
O Manualy, after you start Teamcenter.




[image: image3.png]Cusston3/ 14

You can add additional applications to the primary or secondary listings
inthe navigation pane.
Sesctons:

O Faise

O Tre
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How o you open a perspective in the rich cent?.

oot sttt ooy
1 Choose the perspective from the Window->Open Perspective menu.
] Cick the appiicaton button nthe navigation pane.

01 Double-clck an abject n a navigation view to open the perspecive.
‘associated wih that objecttype.

] Select an object n 3 navigation view and use the Send To shortcut meny.
‘command to select an appiication.




[image: image5.png](Cuestion 2774
Perspeciives are made up of what?

Sesctons:

O Edtors
O Views and edtors
© Windows.




[image: image6.png]Question 8/ 14
Why do you configure primary applications?

secctone
O To access your Home folder, workist, saved searches, and Web fnks.
(O To access your most frequently used Teamcenter applcations.
O To access your most infrequenty used Teamcenter applications.
© To access your most frequently used fems.



[image: image7.png]Question 7/ 14
What menu commandis usedto change your user information?

secctone
O Edit>Options.
O File~Preferences

O Edit>User Setting
O File Session




[image: image8.png](Cueston 2774
How can you customize the toolbar?

oot sttt ooy
) Change the order of buttons on the toobar.
[J Remove buttons fromthe toolsar
[ Add buttons to the toobar.




[image: image9.png]Question 9/ 14
Ifno folder s selected, whatfolder is the default folder for newly created

database objects?.
secctone

© Home folser

O New folder

O Mail folder

© Newstuff folder




[image: image10.png]Question 10/ 14,
What do folder objects contain?

Sestons
O References to other objects.
© Revisions
O Named references.
© tems.




[image: image11.png]Gusston ToTe
When the folder is delsted, the contents of the folder are also deleted

from Teamcenter.
Seitons:

O Faise

O True




[image: image12.png]Queston 12774
Which of the following actions can you perform using the
View—Properties command?
Seeot sttt oy
) Moy the propertes of a singl object.
1 View object properts.
1 Modiy the propertes of mulipl objects simutaneously.
1 Print obiect properties.




[image: image13.png]Question 13/ 14,

Object properties, such as name and description, f checked out, can be
modiied n the Summary view.

Sesctons:
O Faise
O Te




[image: image14.png]Question 14014
You can change ownership of the selected object from the Properties
dialog box.
seectone

O Faise

O Te




[image: image15.png]Question 1/15.
By Teamcenter efault setiing, what objects are includedin the item

structure?
St 3 st sy
[ temrevision
[ tem master form
[ kemrevision master form
[ Dataset




[image: image16.png](Question 2075
Whatis a Teamcenter item?

oot sttt ooy
) One of the fundamental objects used to manage data in Teamcenter.
[ A Teamcenter object that represents a single proguct revision.
] A container objectt reference other Teamcenter data (e.g.datasets).
] A Teamcenter object used to buik product structure.




[image: image17.png]Question 2/ 15
Only one sequence can be active at any given time for an item revision

Sesctons:
O Tre
O Fakse




[image: image18.png]Question 4/ 15
Which are user-specified relation tjpes?

oot sttt ooy
) anifestaton reiaions
) Specificaton reitions
[ BOM view and BOM view revision
[ Aternate D




[image: image19.png]Question 5/ 15
Which of he following is used to capture changes to dataset objects?
secctone

© Versions.

© Revisions

O sequences




[image: image20.png]Qusston 8075
You can identity the files associated with the dataset by viewing which of
the following?
secctone

© Object references.

O Directiodel fies

O Named References




[image: image21.png]Gusston ToTE
Which of he following is true aboutthe datasetversions?

secctone
O Aloptions are correct.

O When the version it is excesded,the eariest version of the dataset is
purged from the database i order make room fo the new version.

O The defaut version i thelatest.
O Dataset versions can be used 0 revert 0 a previous versin of the dataset




[image: image22.png]Question 8075
What are the reasons for using different groups and roles?

St 3 st sy
01 Modity access privieges on an object you own.
) Manage data access privieges.
] Organize data according to which group created .
1 Define and control the review and approval processes.




[image: image23.png]Question 9/ 15
Afier you log on, you cannot change your user group and role sefiings.

Sesctons:
O Faise
O True




[image: image24.png]Question 10775
What action can users take on an tem checked out by another user?
Sestons

O Checkoutthe tem.

O View the fem, f ranted the abity o the view the tem.

O Moditythe tem properties.




[image: image25.png]‘Question 11/15
What user action intiates an implicit checkout?

secctone
O View tem propertes.
O Logoft.
O Open a dataset for modifcation and an automatic check out occurs.

O Use the Check-In/Out commands on the Tools menu o check out an
object.




[image: image26.png]Question 12/ 15
When multiple queries are run using the same search form, Teamcenter

appends a unique number to the search results name. Why?
St 3 st sy

1 o that you can differentiste between the mulipl Search resuts by unique

) 5o thatthe name on the search resuts window maiches the name of the
search form.

01 50 that you can choose (by name) and display previous search resuts
instead of searching again.




[image: image27.png](Question 12005
‘The report generation wizard in Hy Teamcenter quides you through the
steps required o generate a report
Sesctons:

O Faise

O True




[image: image28.png]Question 14715
Can you share saved searches with ofher users?

Sestons

O Yes, no agministative privieges are nesded.

O No, you can only view searches you created and saved i the My Saved
Searches folder.

O No, only adminstators can.




[image: image29.png]Qusstion 15075
Where do you find saved searches?

oot sttt ooy
[ Search History
[ My Saved Searches.
[ Edit- Search.




[image: image30.png]Gusston o
What are the advantages of project smart folders?

Seeot sttt oy

1 Show data assigned to a project.

) Fiter data assigned to a project, based on any property of the object, s set
up by adminstators.

1 Organize ata assigned o a project




[image: image31.png]Question 2/ 14
When can items be assigned o projects?

oot sttt ooy
[ Automaticaly, after the tem’s created
1 When the fem's created, using the New Item dalog box

1 Automaticaly, upon tem creation
] Manualy, after the fem s created




[image: image32.png]Question 2074
Which description best defines project's privileged team members?

Sestons

(O Project team member wi privieges to modify project informaton.

O Project team members with privieges to assign of remove objects from their
projects.

O Teamcenter user with privieges {o create and adminiter projects.
O Users with read privileges to objects in a project.




[image: image33.png]Question 4/ 14
A product structure is:

St 3 st sy
[ Classificaton herarchy.
) Sometimes calld a bil of materils (8OM).
[ An indented view of the assembles and piece parts.
[ A workflow process.




[image: image34.png]st s
You see a BOM view revision object associated to which objects in

assemblies?
secctone

O Folder

© Dataset

O temrevision




[image: image35.png]Question 8/ 14,
Adefault revision rule can be set for Structure Manager.

Sesctons:
O Tre
O Faise




[image: image36.png](Cueston 704
Precise assembly structures are fixed structures of items configured
with specific item revisions.
Sesctons:

O Faise

O True




[image: image37.png]Question 8/ 14,
By Teamcenter default seting, the background color of an imprecise.
assembly structure in Structure Manager is:
Sesctons:

© whte

O velow

O Green




[image: image38.png]Question 5014
You can view visualization data in Structure Manager.

Seitons:
O Tre
O Fakse




[image: image39.png]Question 10/ 14,
How can you create a product structure in Teamcenter?
St 3 st sy

1 Manualy, in My Teameenter.

) Manualy, in Structure Manager.

1 import  rom your CAD system.




[image: image40.png]Question 11/ 14,
When you import a structure from a CAD system, you must manually
synchronize the structure with any changes to the native CAD design
when working in Integration mode.

Sesctons:
© Faise
O True




[image: image41.png]Gusston e e
Choosing the Save command with muliple Structure Manager windows
open only saves the changes to the current window.
Seitons:

O Faise

O Te




[image: image42.png](Cuestion 12074
Concurrent updates are possible in a single-level assembly
‘Teamcenter resolves the updates when they are saved.
Sesctons:

O Tre

O Faise.




[image: image43.png]Qusstion 14014
What kind of parts are interchangeable with a particular componentin an
assembly?
secctone

O imprecise components

© Atemate Ds.

O substiute components

O Replacement components




[image: image44.png]Question 1010
By Teamcenter efault setting, what attributes must be the same to pack

product structure lines?
St 3 st sy
0 Variant condiion
O temp
[ Oceurrence note:
0 Find number
O Quantiy




[image: image45.png]Question 2070
The BOM view revision (BVR) may have multiple markups associated
with it, but only one markup may be active.
Seitons:

O Faise

O True




[image: image46.png]Qusstion 2000
Reasons fo compare a product siructure include:

oot sttt ooy
1 Find differences between differently configured structures.

) igentfy component changes between assermbles.
[ Test for consistency between muliple views of the same tem.




[image: image47.png]Question 4/ 11
You can limitthe assemblies included in the product structure.
‘comparison by collapsing assemblies displayed in the product structure.
Sesctons:

O Faise

O True




[image: image48.png]Question 5/ 11
You can use the Properties view to edt the properties ofthe node.
currently selected in the Relation Browser view, assuming the object
associated with the selected node is checked out, and you have the
appropriate permissions.

Sesctons:
© Tre
O Fakse




[image: image49.png]Queston £770
Where-used searches are used to:

seectone
O Show the saved queres that ind the part.
O Find assembles that contan, or use, the selected tem or tem revision.

O Fing objects i the Teamcenter database that contai a reference o the
selected part or component.

© Listthe chid parts of the assembly.




[image: image50.png]Question 7/ 11
Where-referenced searches are used1o:

secctone
O Fing all assemblies that contain, or use, the selected fem or fem revision.
O Listthe chid paris of the assemby.

O Fing objects i the Teamcenter database that contai a reference o the
selected part or component.

O Show the saved queries that find the part




[image: image51.png]R T s e
classes in the Classification application?
Sestons

O Classificaton object

O cass.

O Group

O View




[image: image52.png]Question 3/ 11
By Teamcenter default setting, the only Teamcenter objects that can be

classified are:
St 3 st sy
[ Datasets
[ tems.
[ Forms.
[ temrevisions
[ Folders.




[image: image53.png]Question 10/ 11
Asingle object can be classified multiple times in different classes.

Sesctons:
O Tre
O False




[image: image54.png]Queston 11000
What methods can you use to locate the storage class that best matches
the atributes of the object being classified?
Seeot sttt oy

] Use the Search Class dialog box.

] Browse the clssification hierarchy tree.

1) Use the quick search feature.




[image: image55.png]Question 1/11
3D visualization data s stored in a DirectModel dataset.

secctone
O Faise
O True




[image: image56.png]Question 2/ 11
Inthe Viewer view, whattab in the Preferences dialog box controls the.

model display modes and feature line options?
secctone

O 6nig

O General

O Display

© Selection




[image: image57.png]Question 3/ 11
Inthe Viewer view, the preferences in the Selection tab in the.

Preferences dialog box control which of the following options?
oot sttt ooy

[ Zoom the part

[ Colorof the part

] Display a bounding box around the part

01 30 display




[image: image58.png]Qusstion 40770
Aworkflow process can have any number of tasks amranged in a serial
or parallel progression.
Sesctons:

O Faise

O True




[image: image59.png]Question 5/ 11
When initiating a new process, how o you know which process
template to assign?
Sestons
O Assign based on the amount oftime available to complete the process
O Assign based on company practices.
O Assign based on the number of signoffs required




[image: image60.png]Question &/ 710

Which o the following views include the task instructions when the task
is selected within the Tasks to Perform or Tasks to Track folder in the.
Viewer view?

St 3 st sy
[ impact Analysis view
[ Process View
0 Workfiow view
] Task View




[image: image61.png]Queston 7000
Inthe araphical representation of a process in Process View, a green
traffic light symbol indicates the taskis pending.
sesstone:

O Tre

O False




[image: image62.png]Question 8/ 11
When you start a new workflow process, you must assign a signoffteam
to perform the signofffor each review taskin the process.
Seitons:

O Faise

O True




[image: image63.png]Question 9/ 11
What methods can be used to assign  signoffteam?

oot sttt ooy
) Assion the task using an assignment st
] Assign the task using the navigation pane.
(] Assion the task 0 a single user.
[ Assign the task to a resource pool.




[image: image64.png]Question 10/ 11
When should a task be delegated?

Seeot sttt oy
0] To avoid duplcaton of effort
] When the task s assigned to a resource pool
1 When it wiltake an extended period of time o perform the task.




[image: image65.png]Question 11000
When you subscribe to a resource pool, a folder for the resource pool is
addedto your My Workiist inbox).
Seitons:

O Tre

O False




[image: image66.png]Qusstion 1108
Which Microsoft Office applications support Client for Office for

Teamcenter?
oot sttt ooy
[ Microsoftexcel
[ Microsoft PowerPoint
[ Microsoft Visio
0 Microsoft Outiook
[ Microsoft Word




[image: image67.png]Question 2/ 18
Which Microsoft Office applications supportlive connectiy for

Teamcenter?
oot sttt ooy
[ Microsoftexcel
[ Microsoft word
) Microsoft Outiok
0 Microsoft PowerPoint
[ Microsoft Visio




[image: image68.png]Question 3/ 18
Whatis the name of the tab that contains a ribbon of buttons and options
for connecting to Teamcenter?
Sestons

O Review

O Markups

O Teamcenter

O Add-ins.




[image: image69.png]Question 4/ 18
Which bution allows you to browse Teamcenter folders in tree view?

Sestons
O Browse
© Open
O search
© Navigate




[image: image70.png]Question 5/ 18
What export output option must be setto enable live Excel?

secctone
© Use Excel Template.
O Live integration with Excel
O Work offine and Import
© Export All Visable columns.
© static Snapshot




[image: image71.png]Gussten £t
Which Microsoft Office application allows you to synchronize your

Teamcenter workflow tasks?
Sestons
O Microsoftexcel
O Microsoft Visio
O Microsoft Word
O Microsoft PowerPoint
O Microsoft Outiook




[image: image72.png]Question 7078
Change Manager works with what other Teamcenter applications to

manage product changes?
St 3 st sy

[ Workfow Viewer

) Schedule Manager

[ Structure Manager




[image: image73.png]Question 8/ 18,
Why do you create a new change notice, ifusing the Teamcenter default
Change Manager functionality?
Sestons

(O To address the approved change request

O To dentiy a problem

O To address the problem report




[image: image74.png]Qusstion 3078
Which of he following is not included in a problem report if using
Teamcenter default Change Manager functionality?
secctone

O Description of a problem or enhancement

O preliminary assessment of a problem

O Specify when an ECN akes effect

O Steps to reproduce a problem




[image: image75.png]Question 10/ 18
What are the three change states iniially configured with the
‘Teamcenter efault Change Manager functionality?
oot sttt ooy

1 Maturity

[ Elaborating

[ Closed

[ Closure.

[ pisposition

[ Investigate




[image: image76.png]Question 11/ 18
In the Teamcenter default Change Manager functionalit, the PR, ECR,
and ECN are created only when the status of the Closure change state.
is:

Sestons
© Canceled
O Closed

© open
© On hold




[image: image77.png]Question 12/ 18
Inwhat change folders are key items organized in the change object

structure?
Seeot sttt oy
[ solution tems
[ Reference ltems
[ implemented 8y
[ impacted ttems.
[ Problem Items




[image: image78.png]Question 13/ 18,
Which of the following change objects can be defived from another
change object,f using Teamcenter default Change Manager
functionalty?

St 1 st sy
[EE3
Deen
ek




[image: image79.png](Cuestion 14018
‘Supersedure is used to track the history of replacement parts and can

be viewed only in Structure Manager.
Sesctons:

O Tre

O False




[image: image80.png]Qusstion 15078
Which of he following methods can be used to create a new or
replacement tem to address the change?
oot sttt ooy

) Revise the problem or inpacted fem

] Create a new problemreport

1 Copy an existng tem

1 Use the File—lew command




[image: image81.png]CQueston 18718
The thin client cannot be used for which of the following:
seectone

O Participating in workfows.

O Viewing graphic data using embedded visualzation

O Adminstration and configuraton tasks.




[image: image82.png]Question 17/ 18
The thin client requires the Teamcenter client software installed on the.
local computer.
Sesctons:

O Tre

O Fakse




[image: image83.png]Question 18/ 18
Which Teamcenter functionaliy is not available in the thin client?
Sesctons:

O Change Hanager

© Structure Manager




